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Why is Knowing How to Combine PDFs Essential?


April 2, 2019








Almost every PDF software program provides users with the function “Merge PDF.” This feature is a standard in many programs that can edit PDF documents and is quite helpful.

Nevertheless, as our experience has shown, not everyone uses this feature. Why? Well, some people just don’t really need it. But many simply aren’t aware of the benefits of combining PDF documents.

Due to ignorance, some people even prefer an old-school workaround: printing the PDFs on paper, rearranging them as desired and later scanning them to send them back. Not very smart time-wise, nor very environmentally friendly. 
 
Therefore, we decided to shed some light on how, why and when you may want to combine PDFs as well as the process for combining PDF files.
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Benefits of Combining PDF Documents

Sharing Data with Ease

When you need to upload or attach several documents, problems may arise. While most email services and social networks enable users to attach multiple files, some platforms still have a one-file limit.
 
For instance, you may want to email your resume, recommendation letter, portfolio, and some certificates, but are only allowed one file attachment at a time; what will you do? What is your strategy for handling multiple file uploads?
 
Combining your files into one PDF document is one of the easiest solutions. There’s no need to send each document separately, you can just merge them into a single document and upload it seamlessly to whatever platform you need.


Easy Document Management for Large Projects 

Large projects often require multiple teams and a great number of documents including plans, change requests, progress reports, and so on. 

Individuals, teams, and departments, are often required to provide routine reports regarding tasks, goals, and stats.

 How can you efficiently manage all of those reports without wasting time searching for this or that document? 
 

To showcase all the results and
conclusions, it may be a good idea to combine the various reports into one big
file available for every team.



If you consolidate several reports into bigger PDF documents structured according
to aspects such as data, department, task, or goal, it will reduce the number
of files necessary and make the search process much faster. 

You won’t need to work with several files
for presentations or emails, just use one PDF document with all the necessary information
and skip the hassle.

Faster and Smarter Printing

There are two possible scenarios for needing to print out numerous documents:

I. You click open your files and send them to print one by one. 
II. You merge your files into one in few clicks and print it out in minutes. 

Option one really only serves as an exercise in patience. Instead of wasting time clicking away and losing track of what’s already printed and what you have left, print once and dedicate your valuable time to more important tasks.

Scanning and Merging

If you scan a large quantity of content such as a 30-page contract or several pages out of a book, you’d definitely prefer it to be one file. However, errors or technical issues can interrupt the scanning process.
 
What do you do if the scanning process was interrupted? Simply save the pages you have already scanned and keep scanning. When you’ve finished, combine all of your files into one PDF. 




Combining PDFs on Windows, Mac, and
Linux

How to Combine PDFs on Windows

If you are a Windows user, an optimal solution is to use Adobe Acrobat DC. It’s an all-encompassing and time-tested software program for editing your files.

Not only can you combine your existing PDF files, but you can also convert and merge Word, Excel, PowerPoint, audio files, video files, and even web pages into one PDF document. 

Before you create the final document, you can preview it, change the order of pages, and delete any unnecessary pages.

If this sounds like what you need, check out the free trial of Adobe Acrobat DC before paying for one of the available plans.

The process of combining with Adobe Acrobat DC is the following:


	Download and install the software.
	Select Tools and then Combine Files. 
	Click Add Files and upload the files you want to combine. 
	 Rearrange, delete, and preview pages.
	Click Options and choose smaller, default, or larger file size depending on your needs. 
	When you’re finished arranging the pages, just click Combine.
	Save your document by clicking File>Save As>Location of File. 


One problem you may face while trying to merge PDF files with Adobe Acrobat DC is speed. When you open large PDF files such as books, the software works much more slowly.

Another
disadvantage that many users complain about is the price for the paid version
of Adobe Acrobat DC. If you find it rather pricey, you can try out other free
Windows-based alternatives that may have fewer features but are just as helpful
when it comes to combining multiple PDF files. 

Finally, Adobe Acrobat DC is not always as reliable as you could think and even vulnerable. Unless you regularly update it, you may put at risk the security of your data. This is a common issue in many companies with employees that got used to the old version and keep using it. 

It is a must to update the software to reduce security risks. If you would like to avoid spending time on constant updates, perhaps, it is better to stick to web applications that maintain everything for you and lower security risks almost to zero.

How to Combine PDFs on Mac

Mac offers
some practical built-in tools for editing and viewing content that Windows
lacks. Application preview is one of its hidden gems. So, if you are a Mac
user, you don’t need to buy, download, or install anything to merge PDFs.

Here’s
a brief guide on how to merge PDFs with the Preview app:

	Open all the files you want to combine in the Preview app.
	Open the View menu for each document and click Thumbnails to see page thumbnails in the sidebar.
	Drag and drop individual page thumbnails or the whole PDF document into another thumbnail to combine them and create a single document.
	You can use the Shift key to select a continuous range of pages or the Command key to select page thumbnails from anywhere in the file and add them to other files.
	Use the toolbar to arrange pages. You can reorder pages as well as rotate them. If you have any pages you don’t need in the final document, you can also delete them.
	When the document looks good and is well-structured, make sure to save it. Choose File > Export as PDF and save the merged PDF file. Note: There are upsides and downsides to the Preview app. You can drag any PNG, JPEG, or any other standard image format into the PDF file, but you cannot drag web pages, Word files, or Excel files directly into your PDF. This is why sometimes there is a need to resort to third-party options like Adobe Acrobat DC.




How to Combine PDFs on Linux

If
you want to merge PDFs on Linux, the process can be a bit different from doing
it with a Mac or Windows interface, but it’s not any more complicated. If you
know the steps, it will take you just a few minutes to
combine any files you want to even if they’re scattered in different folders.

We
will cover a few methods you can use to combine your PDF files on Linux.

PDFtk Tool

Pdftk is a handy tool if
you want to merge PDF files and organize data in one document. Install PDFtk as
shown below.

apt install pdftk

When the installation is
complete, you can
start combining documents. For
instance, if you have two PDFs you want to make one, just run the following
command:

pdftk file1.pdf file2.pdf  cat output merged_output.pdf

PDFunite Tool

Pdfunite
is a part of a PDF rendering library called Poppler-Utils. So, to install Pdfunite, first you need to
install the Poppler-Utils package as shown below.

apt install poppler-utils

Once you have it installed, you can start merging your files. If, for example, you have three documents in the directory, the command will be:  
 
 pdfunite file1.pdf file2.pdf file3.pdf merged_output.pdf

It’s as simple as that.

PDFSam

If
the methods mentioned above do not appeal to you, PDFSam is the best
alternative. This desktop application has three variants: Basic, Enhanced, and
Visual. PDFSam Basic has more than enough features necessary to combine your
PDF documents.

The
steps for combining your files are the following:

	Download and install
PDFSam.
	Open the app and click Merge on the left column.
	Then click Add button on the right column.
	Select your PDF files. 
	Arrange your PDF files
by selecting a PDF and clicking on the arrow buttons to move the file up or down.
	Name your new document
and select the destination folder.
	Click Run.
	Your PDF is ready! You
can now check it out in the folder you selected for it to be saved.


With
PDFSam you can also split, rotate, and extract pages. If your needs go beyond
what is offered with these features, you can upgrade to PDFSam Enhanced or
Visual for a wider range of options.

Other methods: Ghostscript, Using Convert tool 
– https://linoxide.com/linux-how-to/merge-pdf-files-linux/

Key Takeaway: 

The main benefit of combining PDFs through desktop software is the ability to work offline without relying on your Internet connection. If you’re willing to spend some time on installations and software updates, then this method will work well for you.

How to Combine PDF Files On Mobile Devices

If you have an urgent need to share an item in one
document, you don’t necessarily have to run to your laptop. 

There are some user-friendly applications available that can help you combine PDFs on-the-go from your mobile device. Regardless of whether you are an Android, iPhone or Windows Phone user, there is a solution for you. 


Merge PDF Files on iPhone and iPad

If
you need to combine files to make one document on an iOS-powered device, there
are several applications on the Apple Store that will allow you to do this.
PDFelement and PDF Expert are some of the most popular apps available to help
you out.

PDFelement is a robust application that allows you to make a variety of edits and, of course, lets you merge your PDFs. After just four simple steps and a few minutes of your time, your document will be ready.


	Download and launch the app.
	Import your PDF documents to the local list.
	To enter the editing mode, tap the icon in the upper right-hand corner.
	Select all the files you need and tap the Merge button at the bottom of the screen. 
	Finally, you can save the PDF document, open it in another application or share it.


Another way to merge and edit your PDF on an iPhone or iPad is by using PDF Expert. It helps create professional-looking documents that can be easily shared with your colleagues, boss, clients, or friends.

Combining
with PDF Expert is a breeze, just three steps and you’re done.

	Install and open the application.
	Tap Select at the top and choose the files that you want merged.
	Tap the Merge button.


You
can annotate and edit your PDF as well as create outlines and bookmarks
with the help of PDF Expert.

Merge PDFs on Android

With
Android, can also be breezy with the right tools. We recommend PDF Suite. It is one of the most
reliable apps we’ve seen with a variety of features including combining PDF,
and it works without hidden prices and other inconveniences common with this
software. Here are five simple steps to merge your documents into one PDF file.

	Download and install the PDF Suite application on your device.
	Open the application and select the Merge PDFs option.
	Choose documents from the Storage and tap Mark at the bottom of the screen.
	Look through the selected documents and upload another one (if needed) by tapping the + button.
	Tap the button with the fan icon(just over the + button), type in the name of your new document, and get your files merged.






Merge PDFs on Windows Mobile Devices

If you are a resilient Windows Phone users and you’d like to merge your PDFs asap, you have several options available. We recommend Ultra PDF Editor. This is an advanced multifunctional application that offers a great number of editing opportunities.
 
However, if you only need to combine your files there is a standard course of action just as there is for all the previously mentioned Android and iOS solutions.

	Install and open the application.
	Tap the Merge option on the left side of the screen just below the Fill Form feature.
	Select and add files by tapping the +Add Files button.
	If you need to, you can reorder pages or remove any unnecessary files.
	Save the PDF document.
	After the document structure is set, you can use tools to highlight and underline text, add comments, and use a freehand-writing or drawing tool.




Key Takeaway:

Mobile applications come in handy when you urgently need to edit and use a PDF document, or sometimes just to skip the hassle of downloading a desktop application. Still, there is room for improvement. Compared to PC software, most of the mobile applications offer a limited number of features. Therefore, if you need to not only combine PDFs but also to convert other digital formats into PDF, edit, and merge documents, you’ll have to switch to a computer, install PDF software program, or take advantage of other web solutions such as the ones we’re about to show you.

How to Combine PDF Online?


If you want to organize your data and PDFs into one PDF document, you can also do it via web-based applications and avoid spending time on installations and updates, and space on your computer. As long as you have an internet connection, this is a great method.

Here are some of the best PDF tools for combining files online according to user feedback. Scroll down to find the optimal solution for your needs.

Combine PDF



Combine
PDF— the name speaks for itself. You can use it to combine PDF documents and
images (BMP, GIF, HEIC,
HEIF, JP2, JPEG, JPG, PNG, PSD, TIF, TIFF, XCF.) in a literally just a few
clicks.

	Drag and drop your PDF files and images or click the Upload Files button to select files and upload them.
	Click the Combine button and watch as the files are immediately merged and downloaded.




PDF Merge



PDF
Merge, powered by Soda PDF, is a tool similar to Combine PDF. The steps for combining
PDFs into one file are almost the same. 

	 Upload files one by one to merge.
	 Click on the Merge button and your document will be ready in 10 seconds.
	You can not only view but also edit the document directly in your browser before you save and download the new document.


As
you will notice, there is a slight difference between these two web-based apps.
In PDF Merge, you cannot drag and drop files. Instead, you have to upload each
file separately, which can be inconvenient. Also, this app works only with PDF
files; Doc files or images can’t be combined.

The
upside of this web solution is the ability to make basic edits in the browser
prior to download.

Sejda



Sejda is another web-based program that provides a PDF and image combining function. The advantage of this program lies in some of the additional settings it offers. For example, you have options such as ‘Include only specific page ranges,’  ‘Double-sided printing,’ and ‘Make all pages same size.’

To combine PDF files and images with Sejda, just follow these steps:


	Drag and drop files onto the page or upload them from OneDrive, DropBox, Google Drive or from the URL of the file.
	 Click Merge PDF or More Options to optimize the document prior to merging.
	When all of the files have loaded and settings are as you want them, just click Merge Files.
	Now you have the option to save your document in a cloud storage site, download it, or share it via email.




SmallPDF



SmallPDF is not that ‘small.’ in fact, it
boasts 17 PDF tools including the option to merge PDF files. This software is
ideal for users who produce and/or share PDF
documents on a regular basis.

To combine PDF documents with SmallPDF:


	Upload the files from Google Drive or DropBox, or just drag and drop them onto the page. 
	Use the File Mode or Page Mode functions to rearrange the pages. 
	Click Merge PDF! to combine your PDF files.
	Download or save the document onto Google Drive or DropBox.
	Split, rotate, edit or compress the document if needed. 


Note: When the free limit is reached, you offered to sign up for Smallpdf Pro or begin a Free Trial.

PDF Real




PDF Real is an easy-to-use web solution with a neat and tidy interface. This simple and minimalistic program free from ads and pop-ups has PDF tools clearly arranged to help you conduct PDF work quickly and anonymously. 

In the upper right-hand corner, there is a search bar you can use to search for the tools you need to create and edit your PDF document.

When
it comes to combining PDF documents, PDF Real is by far the fastest tool
available. Here are the 3 main steps for having your PDF documents combined
into one PDF file.

	Step 1 – Click Choose File and upload your documents. 
	Step 2 – Click Merge, which will consolidate your files into one before automatically downloading the resulting PDF. 
	Step 3 – Use any of the 15 other tools provided to optimize your PDF document quickly and efficiently.


PDFReal also offers a set of not so common to find features, such as how to flatten a PDF, turn a PDF to grayscale, extract images from PDF files, delete pages from PDF, how to rotate a PDF and even provides a tool to “explode PDF” files, which basically turns each page of a PDF file into a single file.

Why Choose FoxyUtils?



FoxyUtils
is an advanced web solution for productive, portable, and cost-efficient document management. It
helps users organize and share data securely while also supporting
environmental initiatives to reforest our planet and fight global climate
change. 

7 Highlights of FoxyUtils:

	Merging files is easier than over due to its user-friendly interface.
	This cloud-based web app has zero installations and no software updates.
	You don’t need to run any specific commands to combine PDFs.
	It provides a wide range of useful document editing and managing tools that go beyond combining PDF
documents. With FoxyUtils you won’t need to switch between several programs to access
different PDF editing functions.
	It is super easy to merge and share with FoxyUtils. You can combine and edit your documents and then immediately email the link with the new PDF file to the collaborator just in one click.
	Maximum data security and the ability to store your files anywhere from 7 days to up to 1 year (Premium Plan).
	FoxyUtils works on any computer that runs modern web browsing applications.
	By combining PDFs on the FoxyUtils platform, you contribute to the Tree Planting Project and play a part in helping us save our planet.
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